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Abstract. Many students find it difficult to research Physics. This is partly
because of the view that physics is still far from the actual existence and tradition
of networking and teachers no longer use materials related to understanding the
Lampung environment, one of which is conventional video games, and instuc-
tors. Now it no longer includes the notion of the environment Lampung local
wisdom into the curriculum. Meanwhile, the 2013 curriculum requires contextual
assignments so that assignments are meaningful. But in real life Physics is closely
related to the reality of life, one of which is culture. In the culture of the Lampung
people, physics is presented in many ways, such as traditional games and so on.
The type of research used is research and development (Reaserch and Develop-
ment). The development model by Nieveen consists of three stages, namely the
preliminary investigation stage (introduction stage), the prototyping stage (design
stage), and the evaluation stage (evaluation stage).Field trials were carried out in
class X SMAN 1 IX Koto totaling 8 people. The value of learning outcomes in the
form of Pre-test and Post-test scores, then analyzed using N-gain to determine the
development of students’ scores before and after using the media. Based on the
results of the analysis of student learning with an N-gain value of 0.765 or 76,5
which is included in the effective category. So the development of Articulate Sto-
ryline 3 Learning Media Based on Local Wisdom of Traditional Lampung Games
in Improving Science Skills on momentum and impulse materials is very effective
to use.
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1 Introduction

A conscious and systematic effort to build an environment and learning process that
allows students to actively realize their potential is called education. The educational
process aims to improve the skills of students and build good behavior (Yuliati, 2014:
109). Therefore, education is an essential step towards the creation of youth who have
the quality and ability to face and solve problems in social life in each region [1].
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Education is not only a vehicle for transferring science to students, but also for pro-
moting love for their own culture. For this reason, schools are places where education
plays a crucial role in protecting culture. This is in accordance with the thoughts of
Sudarwan Daninins (2008: 2) which reveals that the reliance function or is also consid-
ered an orthodox function means that schools are responsible for paying attention to the
cultural values of the community and building authenticity as a human being [2].

However, students tend to get education with a learning system that only provides
knowledge to students or is considered dead knowledge, which is a common habit
(textbookish) as a result, the insights gained through learning do not mix with the various
cultures they have. (Febriyanti, 2017). The purpose of the curriculum is not in line with
prioritizing learning everyday knowledge. The curriculum applied in Indonesia is the
2013 curriculum, which takes an academic approach. This approach requires students to
understand science from the start and be able to relate it to the physics material they are
studying. The environment is a student’s initial knowledge. By using the generic models
of the teacher as a result, students cannot use this initial knowledge as the basis for
creating knowledge. As a result, students are less sensitive to events in the environment
that are actually related to physics subjects, because the knowledge they gain is less
meaningful and more routine in nature [3].

Science learning needs to be improved so as to create harmony or balance between
scientific knowledge itself and the development of scientific attitudes and local wisdom
values that develop in the community. So that when developing science education in
schools, the socio-cultural environment of students must be seriously considered. This
is because it contains real knowledge that is useful in students’ lives. Therefore, science
education is very beneficial for the students themselves and the community (Asi, 2017).
Physics is a part of science that explains observable phenomena based on human expe-
rience, rational ideas, experiments (Suwindra, 2016). This shows that everyday life is
very close to physics. In physics learning every phenomenon is a statement that focuses
on the surrounding environment [4].

According to Permendikbud number 20 of 2016, students are encouraged to link
technology, arts, humanities, culture and knowledge about the context of society, them-
selves, schools, families, nations, countries, and the environment. And because it is an
environmental area and an international area, teachers must have a strategy to increase
students’ understanding of physics material [5].

Local wisdom is a combination of knowledge and wisdom that grows and develops
in society, both theologically, cosmonogically and sociologically. Education based on
local wisdom is education with teaching and learning activities that have a contextual
nature, by teaching students to always be close to concrete situations that are faced at
any time [6].

Local wisdom is a traditionally institutionalized philosophy for managing nature
and human resources, formulated to clarify the community’s world view of traditional
or eternal natural and social phenomena in the region, which stem from values, ethics,
and behavior. This view of life is the identity of the community that distinguishes it from
other groups (Musanna, 2012: 333–334).
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Juridical foundations of national policies based on regional superiority/regional
wisdom, including:

1. LawNumber 20 RI Chapter 14 Article 50 (5) of 2003 is the Sumba Education Journal
Vol. 01, No. Edition 02, September 2017 confirms that the government controls basic,
secondary and education units. Based on local education.

2. Government regulations No. 17 and 34 of 2010 state "Education based on regional
excellence is education organized after meeting national education standards and
strengthening regional competitiveness and/or comparative advantage".

3. Government Regulation Number 17 Year 2010 Article 35 (2) — Government/City
Government Develops Educational Programs and/or Business Units That Meet or
Approach National Education Standards To Develop International Standard Edu-
cation and/or Advance. Based on the benefits of the program and / or units and /
or regions." In other words, the 2010-2014 Ministry of National Education Strategic
Plan states: Education needs to encourage the importance of knowledge of ecosystem
sustainability and balance, namely humans are part of the ecosystem.

The purpose of education based on local wisdom As mentioned by Jamal Ma‘mur
Asmani (2012:41).

a) Knowing various aspects related to local wisdom in order to understand the local
benefits of the area where students live.

b) Compete domestically and globally, be able to exploit resources and be further
involved in services/services or other matters relating to virtues to generate revenue
while maintaining superior variety, traditions and resources from the region.

c) Students love their homeland, face the future with confidence, and seek to explore
the potential of their area so that they can develop rapidly in line with the demands
of the global and information era.

However, over time, local wisdom has declined and is threatened with extinction
because it is considered to be the difference between local science and science. Mean-
while, local wisdom includes learning activities that can be imitated and grown to be
taught in physics subjects at school (Hariastuti et al., 2020). The era of globalization
has unwittingly become a part of life. Advances in science and technology have helped
loosen these values [7].

Traditional games are one of the many local wisdoms that can be included in physics
lessons in a school, namely traditional games.[8] Lampung province is one of the regions
in Indonesia that has a diversity of local wisdom. The unique heritage of Lampung
includes tapis cloth, intestine embroidery, cigars, ancient performances, and various
other forms of tradition [9].

The game is no stranger to students and even the community, so that it becomes a
guide for studying physics. For this reason, researchers are interested in exploring it.
Meaningful physics learning needs to be able to understand the relationship between
traditional games in society and physics material so that the objectives of the 2013
curriculum can be implemented properly.

Lampung traditional games related to momentum and impulse physics are:
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Fig. 1. Betung Betung Tool in the Ministry of Education and Culture Documentation, 2017

1.1 Betung

This game is known using the term “Jejok”. The game Bedil Betung originates from
North Lampung district which is made of bamboo.

The gun game consists of various tools, namely sleeves, ammunition and guns. As
for how to play the Betung Betung game, that is by pushing ammunition (fruit leak) with
a gun and hand and body movements. Then the hand presses the gun. Efforts to push the
hand when given a force using the hand then the tool will move closer to the fruit leak.
So at that time there was a collision between the bamboo and the leak fruit, which made
the leak fruit crash into the opponent. In the leak there is a change in momentum due to
a given force at a certain time interval.The force that acts is called the impulse force.

1.2 Pidak

The game that comes from North Lampung is called Pidak. Pidak game uses 10 pieces
of rubber on each player. Pidak game is played by 2 players. The way to play the game is
that 2 pieces are arranged in a pile and then hit by the player using their hands. When the
rubber fruit is beaten, the player whose rubber fruit is crushed or broken is considered
to have lost. Meanwhile, the one with the most unbroken rubber is the winner. When
pressing the 2 rubbers that are arranged, then there is a collision [10].

Based on the statement above, the researcher will use the Articulate Storyline soft-
ware application to create learning media which will later assist educators in provid-
ing learning materials and understanding physics material, especially Momentum and
impulses. Articulate Storyline Learning Media is a calm unit that functions as a vehicle

Fig. 2. Betung Betung Tool in the Ministry of Education and Culture Documentation, 2017
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for reading or expressing. Themeans of learning using this software is no less interesting
using other means of reciprocal relationships [11].

Articulate Storyline is a strategy that is able to support designers in digital-based
modern learning based on beginners to professionals. [12] Articulate Storyline 3 is
a computer program which is a tool for developing electronic learning (e-learning).
Articulate Storyline Tiga is presented as an application for making interactive learning
media that is easy and fun (Diane Elkins, et al., 2017) [13].

Articulate Storyline can produce interesting, fun, and interactive learning media
with scenes and slides combined with text, images, animation, video, audio, and quiz
menu support. Students can directly use and interact with the material they are learning,
with what Ashley Cheerson said. In short, Clear Storyline is an application for creating
learning content and learning tests on Storyline (Chiasson, 2016). This is very useful in
the online learning process carried out during the covid19 pandemic because students
can access it online. [14] The final form obtained from this software consists of web-
based rides or HTML5 users, tablets, Android, and Macbook iOS. [15] The advantages
of Articulate Storyline are:

a. Publish topics or productions to HTML5, flash for use on iPad and Android apps.
b. Student progress can be reviewed and tracked using quizzes of 20 different questions

or to create a question bank imported from existing text.
c. Due to the "Layer" and "Trigger" features, objects reflect learning actions. This is

intended to form a user relationship that moves together.
d. Users can create, insert, and style microphones, videos, and images to integrate

multimedia objectives into the coursework.
e. The character bank (emoji) has over 47,000 illustrations and a mix of several photo

characters. We adjust poses and expressions to help students engage in learning
material [16] Disadvantages are:

f. This software cannot create mp4 videos.
g. The foundation style does not offer additional characteristics, does not support

platinum class, does not support priority email, live web chat and screen deployment.
h. Software can’t be used on macbook
i. This spreading unit is more expensive to purchase than other manufacturing tools
[17]

Learning media articulating the articulate storyline has been shown to increase stu-
dent engagement and influence on students’ cognitive abilities (Kartiani & Anam, 2019;
Setyaningsih, 2017; Sindu et al., 2020) [18].

2 Research Methodology

This research uses the type of R&D. [17] In this study, using the example of the devel-
opment of Nieveen. The design of the development model by Nieveen consists of three
stages, namely preliminary investigation (introduction stage), prototyping (design stage),
and evaluation (evaluation stage). At the design stage (prototyping), a media design is
made in accordance with local wisdom, validation is carried out, and it is influenced by
the feasibility of the media to be developed. Validation is done by the validator. The last
stage is the evaluation stage using field tests [19].
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Table 1. The Classification of The Interpretation of The Effectiveness of N-Gain

Percentage (%) Interpretation

< 40 Ineffective

40–55 Less effective

56–75 Effective enough

> 76 Effective

In this phase, we use Articulate Storyline based on local wisdom to get data on
student learning outcomes. Learning outcomes are measured through pre and post test
questions to find out the learning output of students using articulate storyline media. The
value data obtained were analyzed using Ngain with the following equation:

N − gain = Spost−test − Spre−test

Smax imum − Spre−test

Information:
N-gain = Yield Difference
S post test = Average score post test
S Pre test = Average score of pretest
Maximum = Maximum test score [20]
The classification of the interpretation of the effectiveness of N-Gain according to

Hake (1998: 65) can be seen in the following Table 1:

3 Results and Discussion

In the initial problem analysis process, observations and interviews were conducted
with physics teachers at SMAN 1 IX Koto. Based on these observations and interviews,
SMAN 1IX Koto still uses printed books and teaching materials.

The design stage, designing the articulate storyline. Draft 1 Learning Media
Articulate Storyline 3 Based on.

Local Wisdom Traditional Games Lampung In Improving Science Skills obtained
in the prototyping stage there are 2 activities, namely learning activities and learning
activities. The level of learning uses support in this study, namely lesson plans, syllabus,
assessment instruments in the form of pretest and posttest questions.

The design stage was carried out using an articulate storyline draft based on local
wisdomof the Lampung traditional game that was developed. Draft I describes themedia
articulate storyline based on local knowledge created during the prototyping phase. It
contains two learning activities. That is, learning activity 1 includes momentum and
impulse material, and learning activity 2 includes collision material. This phase also
includes the creation of learning tools used to support the survey, such as syllabus, lesson
plans, pre and post test question style assessment tools, and learning implementation
tools.
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Furthermore, the draft I Articulate Storyline produced from the product design stage
was checked for feasibility by experts. Qualitative data in the form of validator comments
and general assessments will be supporting data to improve the clarity of the physics
storyline based on local wisdom developed (Table 2).

Furthermore, field tests were conducted. At the assessment stage at SMAN 1 IX
Koto, students of class X became the research subjects, totaling 8 people. The learning
outcomes of students before and after using the articulate storyline media based on
local wisdom, the learning output values are in the form of Pre-test and Post-test scores.
Then to find out the development of student scores after and before using the articulate
storyline media, an analysis stage was carried out using N-gain. The following data
analysis of student learning outcomes is shown in the following Table 3:

From the student learning analysis table above, we can conclude that the class X
students of SMAN 1 IX Koto after using Articulate Storyline are in the category of
Effectively used in the learning process. This is in accordance with the criteria based on
Hake (1998).

Table 2. Qualitative Data From Validators

Developed media Validator General
Rating

Articulate Storyline 3 Learning Media Based on
Local
Wisdom in
Traditional
Lampung Games

Lecturer of
Physics
Learning
Media

Very worth using

Articulate Storyline 3 Learning Media Based on
Local
Wisdom in
Traditional
Lampung Games

Physics
teacher at SMAN 1 IX
Koto

Very Worth
Using

Table 3. Analysis of Learning Outcomes

Component Physics Class X

Pretest Posttest

Total students 8 people 8 people

The highest score 100 100

Lowest Value 40 70

N-gain Score 0.765625

Percent 76.5625

Category Effective
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Fig. 3. Opening Articulate Storyline 3 application via desktop

The next stage is the prototyping (design stage), which is designing the media
articulate storyline, the stages are as follows:

Then double click until the application opens. Then create the initial slide of the
slide. Then click New project.

On the first page, we can change the page size. Because it’s better to resize before
we add content. The trick is to click on the Design menu.

Fig. 4. First Slide

Fig. 5. Creating a Design
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At this stage, we can add images or animations or change the background directly
from the apk or click the Insert menu, then select Picture.

How to add text is by clicking the insert menu, then selecting Text Box. Change the
font type, font size or font color according to your wishes. Fill the slide with the material
we want such as momentum and impulse material.

Storyline has various forms of buttons that help us in controlling the learning media
that is created. The shape of the buttons consists of various shapes there are rectangles,
arrows, checkbox styles and others. The method is:

1. First we have to go to the Insert menu, then select Button.
2. Click the down arrow provided and select the shape of the button/button to be created.
3. We can change the style of the selected button.
4. We can also change the contents of the Button / Button with an icon, by using the

Button Icons feature

After all the designs are finished, we can immediately publish them by clicking the
top right corner of the media.

Fig. 6. Adding Text.

Fig. 7. Creating a Button
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Fig. 8. Publish

4 Conclusions

Based on the results of the study, teacher validation and student learning outcomes after
using the Articulate Storyline 3 Learning Vehicle Based on Local Wisdom, Traditional
Lampung Games in Improving Science Skills on momentum and impulse materials with
an N-gain value of 0.76 or 76.5 which is included in the effective category. So articulate
media is very effectively used by students, especially during the current pandemic.

Based on the results of the research conducted, the suggestions put forward are: For
the school can make media using materials that are not the same according to the needs
of students, and to make it easier for students to know the material other than that the
media can also be accessed without using the internet. And for researchers, it is better to
use materials that are not the same, so as to produce different media articulate storylines.

References

1. Bakhtiar, D. 2016. Teaching materials based on local wisdom are integrated with STM (Sci-
ence, Technology, and Society) in physics subjects. National Seminar on Education. 21 May
2016. 650- 660.

2. HDPingge. 2017. Local Wisdom and Its Application in Schools. Sumba Educational Journal.
Vol. 01, No. 02. Pg:129.

3. NL Makheasy, Subiki, Supeno. 2019. Development of a Physics Module Based on Local
Wisdom of Central Kalimantan Traditional Games on Momentum and Impulse Material.
Journal of Learning Physics, Vol.8 No.3. Pg:182.

4. PLEldaRosadi, NKKapi, P.Yasa. 2019. TheApplication of Science TeachingMaterials Based
on Local CulturalWisdom to ImproveActivities and Physics LearningAchievements of Class
X Mipa 7 Students at State Senior High Schools. Journal of Physics Education Undiksha,
Vol. 9 No. 2 of 2019 p-ISSN : 25992554 (Print), e-ISSN : 2599–2562 (online). Pages: 76–77.

5. Ministry ofEducation andCulture. 2016.GovernmentRegulation of theRepublic of Indonesia
Number 22 of 2016 concerning Standards for Primary and Secondary Education, Jakarta:
Ministry of Education and Culture.

6. A. Anggramayeni, Berti Yolida, Rini Rita, T marpaung. 2018. The Effectiveness of Local
Wisdom-Based Teaching Materials on Students’ Activities and Learning Outcomes

7. Rumiati, et al. 2021. Analysis of Mechanical Energy Physics Concepts in Traditional Stilt
Games as Physics Learning Materials. JPF (Journal of Physics Education) FKIP UM Metro
p- Vol. 9, No. 2, September 2021, pp. 131–146.



766 V. Wilyanti et al.

8. HDPingge. 2017. Local Wisdom and Its Application in Schools. Sumba Educational Journal.
Vol. 01, No. 02. Pg:131–132.

9. Loviana, S., Islamuddin, AM,Damayanti, A.,Mahfud,MK,&Merliza, P. (2020). Ethnomath-
ematics on filter cloth and traditional Lampung houses. Filter: Journal of Scientific Research,
4(1), 94–110.

10. P. Merliza. 2021. Ethnomathematical Studies: Exploration of Mathematical Concepts in Tra-
ditional Games in Lampung Province. Suska Journal of Mathematics Education (p-ISSN:
2477–4758|e-ISSN: 2540–9670) Vol. 7, No. 1, 2021, p. 24–26.

11. stro Purnama, "Development of Interactive Learning Media Using Articulate Storyline Soft-
ware in Basic Electronics Engineering Subject Class X TEI at SMK Negeri 2 Probolinggo,"
Journal of Electrical Engineering Education 2, no. 1 (2018): 275–279.

12. Satriawaty Mallu, 2020. Implementation of Articulate Storylines in Making Digital Teaching
Materials atMakassar Professional STMIK‖ (2020): 7–9.

13. N. Aprilia 2021. Development Of Physical Learning Using The Articulate Storyline 3 Appli-
cation In Newton’s Law For Class X. JOM FKIP - UR Volume 8 Edition 1 January–June
2021. Pages:3–5.

14. Safira, AD, Sarifah, I., & Sekaringtyas, T. (2021). Development of interactive learning media
based on web articulate storyline in science learning in grade V elementary school. Prima
Magistra: Scientific Journal of Education, 2(2). https://doi.org/10.37478/jpm.v2i2.1109

15. Riyanto, sons of eka prilnali and indelarko hendi, 2009 “Development of desktop and web-
based geographic information system applications” Publisher: ISBN: 978–979–1078–70–2.,
2009.

16. Amri Tanduk Langi Carlina Amri, "Computer Assisted Language Learning" (yogyakarta:
Budi Utama, 2019), 144.

17. Amiroh, Proficient in Creating Articulate Storyline Interactive Media (Central Java: Cipta
Artha Media, 2019).

18. S.Yolanda,RetnoWinarni, SeptiYulisitiani. 2022.TheNewWay ImproveLearners’ Speaking
Skills: Picture andPictureLearningMediaBasedonArticulate Storyline. Journal ofEducation
Technology Volume 6, Number 1. https://ejournal.undiksha.ac.id/index.php/JET

19. Sugiyono, Quantitative, Qualitative and R&D Research Methods, ‖2014.
20. Nieveen, N. 2006. Educational design research: the value of variety. In Van den Akker, J.

Gravemeijer, K., McKenney, S. and Nieveen, N. (Eds). Educational design research. London:
Routledge.

Open Access This chapter is licensed under the terms of the Creative Commons Attribution-
NonCommercial 4.0 International License (http://creativecommons.org/licenses/by-nc/4.0/),
which permits any noncommercial use, sharing, adaptation, distribution and reproduction in any
medium or format, as long as you give appropriate credit to the original author(s) and the source,
provide a link to the Creative Commons license and indicate if changes were made.

The images or other third party material in this chapter are included in the chapter’s Creative
Commons license, unless indicated otherwise in a credit line to the material. If material is not
included in the chapter’s Creative Commons license and your intended use is not permitted by
statutory regulation or exceeds the permitted use, you will need to obtain permission directly from
the copyright holder.

https://doi.org/10.37478/jpm.v2i2.1109
https://ejournal.undiksha.ac.id/index.php/JET
http://creativecommons.org/licenses/by-nc/4.0/

	Development of Articulate Storyline 3 Learning Media Based on Local Wisdom in Traditional Lampung GamesIn Improving Science Skills
	1 Introduction
	1.1 Betung
	1.2 Pidak

	2 Research Methodology
	3 Results and Discussion
	4 Conclusions
	References




